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SUMMARY:  34 
We exposed a microphysiological system (MPS) with intestine and liver organoids to 35 
acetaminophen (APAP). This article describes the methods for organoid production and APAP 36 
pharmacokinetic and toxicological property assessments in the MPS. It also describes the tissue 37 
functionality analyses necessary to validate the results. 38 
 39 
ABSTRACT:  40 
The recently introduced microphysiological systems (MPS) cultivating human organoids are 41 
expected to perform better than animals in the preclinical tests phase of drug developing process 42 
because they are genetically human and recapitulate the interplay among tissues. In this study, 43 
the human intestinal barrier (emulated by a co-culture of Caco-2 and HT-29 cells) and the liver 44 
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equivalent (emulated by spheroids made of differentiated HepaRG cells and human hepatic 45 
stellate cells) were integrated into a two-organ chip (2-OC) microfluidic device to assess some 46 
acetaminophen (APAP) pharmacokinetic (PK) and toxicological properties. The MPS had three 47 
assemblies: Intestine only 2-OC, Liver only 2-OC, and Intestine/Liver 2-OC with the same media 48 
perfusing both organoids. For PK assessments, we dosed the APAP in the media at preset 49 
timepoints after administering it either over the intestinal barrier (emulating the oral route) or 50 
in the media (emulating the intravenous route), at 12 µM and 2 µM respectively. The media 51 
samples were analyzed by reversed-phase high-pressure liquid chromatography (HPLC). 52 
Organoids were analyzed for gene expression, for TEER values, for protein expression and 53 
activity, and then collected, fixed, and submitted to a set of morphological evaluations. The MTT 54 
technique performed well in assessing the organoid viability, but the high content analyses (HCA) 55 
were able to detect very early toxic events in response to APAP treatment. We verified that the 56 
media flow does not significantly affect the APAP absorption whereas it significantly improves 57 
the liver equivalent functionality. The APAP human intestinal absorption and hepatic metabolism 58 
could be emulated in the MPS. The association between MPS data and in silico modeling has 59 
great potential to improve the predictability of the in vitro methods and provide better accuracy 60 
than animal models in pharmacokinetic and toxicological studies. 61 
 62 
INTRODUCTION: 63 
Due to genomic and proteomic differences, animal models have limited predictive value for 64 
several human outcomes. Moreover, they are time-consuming, expensive and ethically 65 
questionable1. MPS is a relatively new technology that aims at improving the predictive power 66 
and reduce the costs and time spent with pre-clinical tests. They are microfluidic devices 67 
cultivating organoids (artificial mimetics functional units of organs) under media flow that 68 
promotes interorganoid communication. Organoids made of human cells increase translational 69 
relevance2–4. MPS is expected to perform better than the animal tests because they are 70 
genetically human and recapitulate the interplay among tissues. When fully functional, the MPS 71 
will provide more meaningful results, at higher speed and lower costs and risks4. Many groups 72 
are developing MPS for several purposes, especially disease models to tests drug’s efficacy.  73 
 74 
Exposure level is one of the most critical parameters for evaluating drug efficacy and toxicity5–12. 75 
MPS allows organoid integration that emulates systemic exposure and is expected to perform 76 
better than the traditional 2D human tissue culture. This technology can significantly improve 77 
the prediction of compound intestinal absorption and liver metabolism4. 78 
 79 
An MPS integrating human equivalent model of the intestine and the liver is a good starting point, 80 
considering the central role of these two organs in drug bioavailability and systemic exposure13–81 
15. APAP is an attractive drug for studying an MPS without a kidney equivalent because its 82 
metabolization is done mainly by the liver16,17.  83 
 84 
The 2-OC is a two-chamber microfluidic device suitable for the culture of two different human 85 
equivalent tissues/organoids interconnected by microchannels16. In order to emulate an in vitro 86 
human oral/intravenous administration of a drug and assess the effects of the cross-talk between 87 
the intestine and liver equivalents on APAP pharmacokinetics, besides the organoids 88 



   

functionality and viability, three different MPS assemblies were performed: (1) an “Intestine 2-89 
OC MPS” comprised of an intestine equivalent based in a culture insert containing a Caco-2 + HT-90 
29 cells coculture, integrated into the 2-OC device; (2) a “Liver 2-OC MPS” comprised of liver 91 
spheroids with HepaRG + HHSteC (Human Hepatic Stellate Cells) integrated in the 2-OC device; 92 
and (3) an “Intestine/Liver 2-OC MPS” comprised of the intestine equivalent in one device 93 
compartment communicating with the liver equivalent in the other by flow of the microfluidic 94 
channels. 95 
 96 
All assays were performed under static (no flow) and dynamic (with flow) conditions due to the 97 
impact of the mechanical stimuli (compression, stretching, and shear) on the cell viability and 98 
functionalities18–20. The present article describes the protocol for APAP oral/intravenous 99 
administration emulation and the respective absorption/metabolism and toxicological analyses 100 
in the 2-OC MPS containing human intestine and liver equivalent models.  101 
 102 
PROTOCOL:  103 
 104 
1. Production of tissue equivalents for cultivation in the 2-OC 105 
 106 
1.1. Small intestine barrier equivalent production  107 
 108 
1.1.1. Maintain Caco-2 and HT-29 cells using the intestine equivalent medium: DMEM 109 
supplemented with 10% FBS, 1% penicillin and streptomycin, and 1% non-essential amino acids, 110 
which is named as “DMEM S” in this manuscript. 111 
  112 
1.1.2. Remove the medium, wash twice with 1x DPBS and add 8 mL of 0.25% Trypsin/EDTA to 113 
dissociate Caco-2 cells grown in cell culture flasks (175 cm2). Incubate for 5 min at 37 °C and stop 114 
the reaction by adding at least the double volume of trypsin inhibitor. Perform the same 115 
procedure for HT-29 cells, adjusting the reagent volumes since a smaller quantity of these cells 116 
is needed and they are maintained in smaller flasks (75 cm2).  117 
 118 
1.1.3. Centrifuge at 250 x g for 5 min, remove the supernatant from both tubes, and resuspend 119 
the cell pellets in 10 mL of DMEM S. Count cells, assuring a cell viability higher than 80%. 120 
Aseptically integrate cell culture inserts in a 24-well plate previously filled with 400 µL of DMEM 121 
S per well in the basolateral side (which represents the human bloodstream). 122 
 123 
1.1.4. Co-cultivate Caco-2 and HT-29 cells at a ratio of 9:121. Use 2.25 x 105 Caco-2 and 2.5 x 104 124 
HT-29 cells to each intestine equivalent in a final volume of 200 µL of DMEM S. Adjust cell 125 
numbers and volume according to the desired number of organoids. Mix carefully.  126 
 127 
1.1.5. Pipette 200 µL of cell solution into each insert’s apical side (which represents the human 128 
intestinal lumen side), seeding 250,000 cells per insert. Co-cultivate the cells in the inserts for 129 
three weeks22. Change the medium at least three times a week, aspirating it from both the apical 130 
and basolateral sides with a sterile Pasteur pipette, taking care not to damage the intact cell 131 
barrier. 132 



   

 133 
NOTE: Proceed with the aspiration on the apical side, so as not to touch the cell barrier (aspirate 134 
by supporting the Pasteur pipette on the plastic rim of the cell insert). 135 
 136 
1.1.6.  Check the tight monolayer formation by measuring the TEER (transepithelial electrical 137 
resistance) every three days using a voltmeter23, according to the manufacturer's instructions.  138 
 139 
1.1.6.1. Perform a blank, measuring the resistance across a cell culture insert without cells, 140 
but with the same cell medium and at the same cell plate.  141 
 142 
1.1.6.2. Calculate tissue resistance by subtracting the blank resistance from the tissue-143 
equivalent resistance, and multiply by the effective surface area of the filter membrane (0.6 cm2). 144 
A good intestine barrier resistance is in a range of 150 to 400 Ω∙cm2. 145 
 146 
NOTE: After 21 days the cells must be fully differentiated and the intestinal barrier formed, so 147 
the intestine equivalents are ready to be integrated into MPS.  148 
 149 
1.2. Liver equivalents production 150 
 151 
1.2.1. Maintain HepaRG cells using the liver equivalent medium, which is William’s Medium E 152 
supplemented with 10% fetal bovine serum, 2 mM L-glutamine, 100 units/mL penicillin, 100 153 
µg/mL streptomycin, 5 µg/mL human insulin and 5 x 10-5 M hydrocortisone, and is named 154 
“Williams E S” in this manuscript. Renew HepaRG media every 2-3 days and maintain cell culture 155 
for two weeks to initiate the differentiation in hepatocytes and cholangiocytes. 156 
 157 
1.2.2. After the first two weeks, add 2% DMSO to HepaRG’s medium for an additional two weeks 158 
to complete the cell differentiation24,25. Grow HHSTeC in Stellate Cell Media (SteC CM), using 159 
poly-L-lysine-coated cell culture flasks, changing media every two or three days. 160 
 161 
1.2.3. Remove the medium, wash twice with 1x DPBS and add 8 mL of 0.05% Trypsin/EDTA, to 162 
dissociate HepaRG cells grown in cell culture flasks (175 cm2). Incubate for 5 to 10 min at 37 °C 163 
and stop the reaction by adding at least double the volume of trypsin inhibitor. Perform the same 164 
for HHSTeC, adapting the reagent volume since a smaller quantity of these cells are needed and 165 
they can be maintained in smaller flasks (75 cm2). 166 
 167 
1.2.4. Centrifuge both at 250 x g for 5 min, remove the supernatant and resuspend the cell 168 
pellets in Williams E S medium. Count cells, assuring a cell viability higher than 80%.  169 
 170 
1.2.5. Generate the liver spheroids combining HepaRG and HHSTeC cells at a ratio of 24:1, 171 
respectively, in Williams E S medium16. Add 4.8 x 104 differentiated HepaRG and 0.2 x 104 HHSTeC 172 
to compose each liver spheroid of 50,000 cells, in a volume of 80 µL. Adjust cell numbers and 173 
volume according to the desired number of spheroids. Mix carefully. 174 
 175 
1.2.6. Using a multichannel pipette, dispense 80 µL of the combined cell pool in each well of 384 176 



   

spheroid microplates, which has round well-bottom geometry.  177 
 178 
NOTE: After four days, spheroids of about 300 µm are formed. 179 
 180 
1.2.7. Using wide-bore tips, transfer the liver spheroids to ultra-low-attachment 6 well plates, 181 
which allows the required “one-by-one” counting. 182 
 183 
2.  Integration of intestine and liver equivalents in a 2-OC MPS  184 
 185 
2.1. Intestine 2-OC MPS assembly for absorption assay 186 
 187 
2.1.1. Pipette 500 µL of DMEM S into the larger compartment of 2-OC and 300 µL in the smaller 188 
one. Aspirate the basolateral and apical media of each intestinal barrier equivalent in the 24 well 189 
plates. Using sterile forceps, integrate one insert per 2-OC circuit, specifically into the larger 190 
compartment. Apply 200 µL of the intestine medium at the apical side. 191 
 192 
NOTE: Avoid the formation of bubbles when integrating the organoids into the MPS. 193 
 194 
2.1.2. Connect the MPS to the control unit, which must be connected to a pressurized air supply. 195 
Set the parameters: a pressure of, approximately, ±300 bar and a pumping frequency of 0.3 Hz. 196 
Start the flow 24 h before the test substance administration. The next day, perform the APAP 197 
treatment. 198 
 199 
2.2. Liver 2-OC MPS assembly for metabolism assay 200 
 201 
2.2.1. Pipette 650 µL of Williams E S into the large compartment and 350 µL into the smaller 202 
compartment, which will receive the spheroids. In the ultra-low-attachment 6 well plates, count 203 
the spheroids using wide-bore tips. Each liver equivalent is composed of twenty spheroids26. 204 
Integrate twenty liver equivalents per circuit, using wide-bore tips, which permits the transfer of 205 
organoids only, into the smaller compartment of a 2-OC. 206 
 207 
2.2.2. Connect the MPS to the control unit, which must be connected to a pressurized air supply. 208 
Set the parameters: a pressure of, approximately, ±300 bar and a pumping frequency of 0.3 Hz. 209 
Start the flow 24 h before the test substance administration. The next day, perform the APAP 210 
treatment.  211 
 212 
2.3. Intestine/Liver 2-OC MPS assembly for absorption and metabolism assay 213 
 214 
2.3.1. Combine the two media (intestine and liver) in a 1:4 proportion, which means 200 µL of 215 
DMEM S in the intestine apical side and 800 µL of Williams E S in the basolateral side. Integrate 216 
intestine and liver equivalents, simultaneously, in the 2-OC. 217 
 218 
2.3.2. Connect the MPS to the control unit, which must be connected to a pressurized air supply. 219 
Set the parameters: a pressure of, approximately, ±300 bar and a pumping frequency of 0.3 Hz. 220 



   

Start the flow 24 h before the test substance administration. The next day, perform the APAP 221 
treatment.  222 
 223 
NOTE: For all experiments, perform each time point in triplicate, which means three separated 224 
2-OC circuits (i.e., 1 and ½ 2-OC devices). The total volume of each 2-OC circuits is 1 mL. 225 
 226 
3. Acetaminophen (APAP) preparation 227 
 228 
3.1. Prepare the APAP stock solution, dissolving APAP in absolute ethanol. On the day of the 229 
experiment, dilute APAP in the respective medium (APAP solution), to a concentration of 12 µM 230 
for “oral administration” and 2 µM for “intravenous administration”.  231 
 232 
3.2. Ensure that the final concentration of ethanol in the vehicle control and treatment 233 
solution is 0.5% for both administrations. For the positive control (100 mM APAP), the ethanol 234 
concentration is 2%.  235 
 236 
4. Test substance administration and media sampling 237 
 238 
4.1. APAP “oral” administration and media sampling 239 
  240 
4.1.1. Aspirate the basolateral and apical media of each intestinal barrier equivalent in the 2-241 
OC. Pipette 500 µL of the appropriate culture medium into the large compartment at the 242 
organoid basolateral side and 300 µL into the small compartment. 243 
 244 
4.1.2. Check for bubbles and proceed with the intestinal barrier equivalent treatment with the 245 
test substance in the apical side, emulating oral administration. Emulate APAP “oral” 246 
administration by adding 200 µL of a 12 µM APAP solution on the apical side of intestinal culture 247 
inserts, which represents the intestinal “lumen side” (Figure 1B). Connect the MPS to the control 248 
unit.  249 
 250 
4.1.3. Collect the total volume from apical and from basolateral sides at the following time 251 
points: 0 h, 5 min, 15 min, 30 min, 1 h, 3 h, 6 h, 12 h, and 24 h15,27. Perform all experiments in 252 
triplicate, at static and dynamic conditions, and collect each sample, of each triplicate, in a 253 
separate microtube. Analyze the samples using HPLC/UV.  254 
 255 
NOTE: Separate apical and basolateral samples. 256 
 257 
4.2. APAP “intravenous” administration and media sampling 258 
 259 
4.2.1. Emulate the “intravenous” route by administering 2 µM APAP solution directly into the 260 
liver compartment. Aspirate all 2-OC medium content. Pipette 650 µL of Williams E S containing 261 
the test substance into the large compartment and 350 µL of the same media into the smaller 262 
compartment which contains the 20 spheroids. Collect all volumes at the following time points: 263 
0 h, 30 min, 1 h, 2 h, 3 h, 6 h, 12 h, and 24 h27,28.  264 



   

 265 
4.2.2. Perform all experiments in triplicate, at static and dynamic conditions. Collect each 266 
sample, of each triplicate, in a separate microtube. Analyze the samples using HPLC/UV.  267 
 268 
5. Instrumentation and chromatographic conditions 269 
 270 
5.1. HPLC analysis 271 
 272 
5.1.1.  Set all relevant parameters for the HPLC analysis according to Table 1. 273 
 274 
5.1.2. Filter the mobile phase through a 0.45 µm membrane filter under vacuum. Filter the 275 
samples through a 0.22 µm pore size PVDF syringe filter (diameter 13 mm) and store them in a 276 
vial. Start the measurement. 277 
 278 
5.2. Stock solutions, calibration standards, and quality control (QC) samples 279 
 280 
5.2.1. Prepare 10 mM of APAP stock solutions in ammonium acetate buffer (100 mM, pH 6.8) 281 
and further dilute with DMEM S and Williams E S cell culture media diluted with ammonium 282 
acetate buffer (1:1, v/v) to achieve the working solutions ranging from 0.25 to 100.00 µM. 283 
 284 
5.2.2. Include a set of calibration samples in triplicate as well as quality control samples at four 285 
levels in triplicate. Prepare these standards by serial dilution. 286 
 287 
5.2.3. Create calibration curves of APAP peak areas versus APAP nominal standard 288 
concentrations. Determine the linear regression fit for each calibration curve. Evaluate the 289 
goodness-of-fit of various calibration models by visual inspection, correlation coefficient, intra- 290 
and inter-run accuracy and precision values. 291 
 292 
5.2.4. Inject blank samples of DMEM S and Williams E S media diluted in ammonium acetate 293 
buffer (1:1, v/v) in sextuplicate. Prepare triplicates of quality control samples in DMEM S and 294 
Williams E S media diluted with ammonium acetate buffer (1:1, v/v) for the APAP concentrations 295 
of 0.50 (LOQ), 4.50, 45.00 and 90.00 µM. 296 
 297 
5.2.5. Ensure that the quality control samples are prepared from a new stock solution, different 298 
from that used to generate a standard curve. Use quality control samples to investigate intra- 299 
and inter-run variations. 300 
 301 
5.3. Validation procedures 302 
 303 
5.3.1. Perform the bioanalytical method validation following the previously reported 304 
procedures29,30. Carry out the chromatographic runs on five or six separate occasions, considering 305 
Williams E S and DMEM S cell culture media, respectively. 306 
 307 
5.3.2. Ensure that calibration points ranging from 0.25 to 100.00 µM of APAP, in DMEM S or 308 



   

Williams E S cell culture media diluted in ammonium acetate buffer (1:1, v/v), are plotted based 309 
on the peak-areas of APAP (axis y) against the respective nominal concentrations (axis x). 310 
Compare the slopes of these standard calibration curves with slopes of calibration curve 311 
prepared in ammonium acetate buffer. Make sure that all calibration curves have a correlation 312 
value of at least 0.998. 313 
 314 
5.3.3. Determine the precision and accuracy (intra and inter-run) for the analyte in the surrogate 315 
matrix using replicates at four different levels LLOQ, low, middle, and high-quality control on five 316 
or six different days. Perform intra-run precision and accuracy measurements on the same day 317 
in DMEM S or Williams E S cell culture media diluted in ammonium acetate buffer (1:1, v/v) 318 
containing 0.50, 4.50, 45.00 and 90.00 µM APAP concentrations (n= 3). 319 
 320 
5.3.4. Evaluate each set of quality control samples containing the APAP concentrations from 321 
recently obtained calibration curves. Test the selectivity of the assays by the degree of separation 322 
of the compound of interest and possible other chromatographic peaks caused by interfering 323 
components. 324 
 325 
5.4. Lower limit of quantification (LLOQ) and limit of detection (LOD) 326 
 327 
5.4.1. Determine the lower limit of quantification (LLOQ) based on the standard deviation of the 328 
response and the slope approach. Calculate using the formula 10α/S, where α is the standard 329 
deviation of y-intercept and S is the slope of straight line obtained by plotting calibration 330 
curves29,30. Estimate the limit of detection (LOD) taking into consideration 3.3 times the standard 331 
deviation of the blank, divided by the slope of the calibration curve29,30. 332 
 333 
6. Tissue equivalents viability/functionality 334 
 335 
6.1. MTT  336 
 337 
6.1.1. Perform an MTT assay to assess organoid viability in all time points of the MPS assay. As 338 
the negative control, use cell media plus vehicle. As the positive control, treat the organoids with 339 
100 mM APAP and 1% NaOH diluted in cell medium.  340 
 341 
6.1.2. Transfer the 20 spheroids of each replicate for individual wells in a 96 well plate, and the 342 
cell culture inserts, containing the intestine equivalents, to 24 well cell plates, placing one 343 
intestine equivalent per well. Wash the tissue equivalents three times with 1x DPBS.  344 
 345 
6.1.3. Add 300 µL of a 1 mg/mL MTT solution, diluted in the respective cell medium, per well. 346 
Incubate the plates for 3 h at standard cell culture conditions.  347 
 348 
6.1.4. Remove the MTT solution from each well carefully by pipetting. Extract MTT formazan 349 
from the intestine and liver equivalents using 200 µL of isopropanol per well overnight at 4 °C.  350 
 351 
NOTE: Seal the lid to prevent evaporation. 352 



   

 353 
6.1.5. Transfer 200 µL of each supernatant to the respective pre-identified well in a 96 well 354 
micro test plate. Use isopropanol as the blank. 355 
 356 
6.1.6. Read the formazan absorbance in a plate reader at 570 nm. Calculate the relative ability 357 
of the cells to reduce MTT (%) using the average optical density of each time point, compared to 358 
the negative control, considered as 100% cell viability. 359 
 360 
6.2. Cytochemistry/Histology 361 
 362 
6.2.1. Fix the intestine and liver equivalents, for 25 min at room temperature, using 4% (w/v) 363 
paraformaldehyde in 0.1 M phosphate-saline buffer, pH 7.4. Wash the organoids 5 times in PBS 364 
buffer for 10 minutes each time. Stain the intestinal and the liver equivalents with 365 
tetramethylrhodamine isothiocyanate-phalloidin or Alexa Fluor 647 phalloidin, 1:50 in PBS31. 366 
 367 
6.2.2. Transfer them to OCT freezing medium for a few minutes to acclimate at RT before 368 
transferring them to liquid nitrogen until the complete freezing. Perform liver spheroids 369 
cryosections about 10-12 µm thick, using a cryostat. 370 
 371 
6.2.3. Mount the tissues sections in mounting medium with DAPI. Examine them by confocal 372 
fluorescence microscopy. 373 
 374 
6.2.4. Freeze the organoids after fixation to perform hematoxylin & eosin staining according to 375 
the established protocols. Mount the slides with mounting medium after slicing the tissue as 376 
described above and take histological images using an optical microscope. 377 
 378 
6.3. High content analysis 379 
 380 
6.3.1. Mitochondrial and nuclear staining of the cells 381 
 382 
6.3.1.1. Reconstitute the lyophilized powder in DMSO to make a 1 mM mitochondrial staining 383 
stock solution (e.g., MitoTracker Deep Red FM). Store aliquoted stock solution at -20 °C protected 384 
from light. Dilute the 1 mM mitochondrial staining stock solution to the final concentration (200 385 
nM) in prewarmed (37 °C) tissue culture medium without serum.  386 
 387 
6.3.1.2. Remove the cell culture media. Add the mitochondrial staining solution to completely 388 
cover the sample and incubate cells for 15-45 min at 37 °C in a humidified atmosphere with 5% 389 
CO2.  390 
 391 
6.3.1.3. Carefully remove the mitochondrial staining working solution and replace it with 2-4% 392 
paraformaldehyde fixative in PBS for 15 minutes at room temperature.  393 
 394 
6.3.1.4. Rinse the fixed cells gently with PBS for 5 minutes. Repeat the washing process twice. 395 
 396 



   

6.3.1.5. Prepare a 10 mg/mL (16.23 M) nucleic acid staining stock solution by dissolving 100 mg 397 
of Hoechst 33342 dye in 10 mL of ultrapure water.  398 
 399 
NOTE: The stock solution should be aliquoted and stored protected from light at -20 °C.  400 
  401 
6.3.1.6. Prepare a 0.2-2.0 µg/mL nucleic acid staining working solution in PBS and incubate the 402 
fixated cells with nucleic acid staining working solution for 10 minutes at room temperature.  403 
 404 
6.3.1.7. Remove the nucleic acid staining working solution and rinse the cells gently with PBS for 405 
5 minutes three times. Cells should be kept in PBS at 4 °C, protected from light. 406 
 407 
6.3.2. Mitochondrial and nuclear staining analysis  408 
 409 
6.3.2.1. Analyze cells using a fluorescence microscope with filter sets appropriate for the nucleic 410 
acid stain (λEx/ λEm: 361/497 nm) and the mitochondrial stain (λEx/ λEm: 644/665 nm). Find cells 411 
by nucleic acid positive staining and quantify cell number. Quantify mitochondrial stain 412 
fluorescence intensity in mitochondria. 413 
 414 
6.4.  Morphometric measurements (spheroids calculations) in ImageJ 415 
 416 
6.4.1. Export High Content Analysis (HCA) images as *.flex files from the Columbus software. 417 
Import .flex files as a grayscale in ImageJ using Bio-Formats plugin32: File > Import > Bio-Formats. 418 
 419 
6.4.2. In the Import Options window, select Hyperstack viewing and enable Split channels 420 
under Split into separate windows. This option will allow the access of all files in a particular 421 
channel (e.g., DAPI, mitotracker, etc.). Do not select Use virtual stack under Memory 422 
management.  423 
 424 
NOTE: It is preferable to use DAPI channel as “dust” in images as culture medium is reduced in 425 
UV wavelength (e.g., 405 nm). 426 
 427 
6.4.3. Adjust pixel size (Analyze > Set Scale) if it was not loaded according to embedded values 428 
in the .flex file. Apply a Gaussian Blur filter to remove the excess of noise and avoid irregularities 429 
in shape contour. Process > Filters > Gaussian Blur. A high value of Sigma (radius) between 2.0 430 
and 3.0 is ideal for most cases. If the stack has several images, apply to all of them (select Yes in 431 
Process Stack window). 432 
 433 
6.4.4. Generate a binary image to separate background and organoids (objects) using a 434 
threshold. Click Image > Adjust > Threshold. Use the red mask to adjust the values according to 435 
the intensity of the image, to fit the organoid shape, keeping the morphology intact. Disable Dark 436 
background if the image has a white background. Click Apply. 437 
 438 
6.4.5. In the Convert Stack to Binary window, choose the Threshold method. Usually, Default 439 
or Triangle are preferred in this kind of image processing. Keep the Background as Dark. Select 440 



   

Calculate threshold for each image if there are several images in the stack.  441 
 442 
6.4.6. Select Process > Binary > Fill holes. Optionally, remove holes from the background. In 443 
Process > Binary > Options, select Black background and execute Fill Holes again. Disable Black 444 
background option before proceeding to the next step. 445 
 446 
6.4.7. Separate objects. For organoids, the watershed method is a good choice. Click Process > 447 
Binary > Watershed. Execute the shape analysis. 448 
 449 
6.4.7.1. Select Analyze > Set Measurements. Several options are available (details in 450 
https://imagej.nih.gov/ij/docs/guide/146-30.html). For organoids, select Area, Mean gray value, 451 
Min & max gray value and Shape descriptors. Optionally, select Display label to identify objects 452 
in the image and Scientific notation. Click OK. 453 
 454 
6.4.7.2. Select Analysis > Analyze Particles. Choose the Size and Circularity limits. Keep 0-455 
infinity and 0.00-1.00, respectively to measure all objects in the image. In Show, choose Outlines 456 
so the objects will be identified. Enable Display results to output results; Exclude on edges to 457 
exclude objects touching borders; Include holes so eventual interior holes in the objects are 458 
considered as part of the main shape. 459 
 460 
6.4.8. Repeat Shape Analysis for every image stack and the results will be appended in a single 461 
table. Export results table in File > Save As… as Comma Separated Values (.csv) file.  462 
 463 
6.5. Real-Time PCR 464 
 465 
6.5.1. Extract RNA from tissue equivalents using a monophasic solution of phenol and guanidine 466 
isothiocyanate, following manufacturer’s instructions.  467 
 468 
6.5.2. Perform the cDNA synthesis by reverse transcription of 1 – 2 µg of total RNA. 469 
 470 
6.5.3. Amplify all targets using gene-specific primers (Table 5) to perform real time quantitative 471 
PCR. Each qRT-PCR contains 30 ng of reverse-transcribed RNA and 100 nM of each primer. 472 
 473 
6.5.4. Follow PCR conditions: 50 °C for 3 minutes (1 cycle); 95 °C for 5 minutes (1 cycle); 95 °C 474 
for 30 seconds, 59 °C for 45 seconds and 72 °C for 45 seconds (35 - 40 cycles).  475 
 476 
6.6.  CYP assay  477 
 478 
6.6.1.  Follow section 2.2 for liver 2-OC assembly. The experimental groups are No-cell control, 479 
APAP 2 µM treatments for 12 h, 24 h, and vehicle control. Follow sections 3.3 and 4.2 for APAP 2 480 
µM preparation and treatment. 481 
 482 
NOTE: To ensure that all the samples will be ready at the same time for CYP assay, start the 12 h 483 
treatment 12 hours after starting the 24 h treatment. Treat the no-cell control of CYP activity 484 



   

with 0.5% ethanol solution, as well as the vehicle control. 485 
 486 
6.6.2. Thaw 3 mM luminogenic substrate stock solution at room temperature and make a 1:1000 487 
dilution in William’s E S. Protect from light. 488 
 489 
6.6.3. Collect spheroids and transfer each experimental group to a well of a 96-well plate. 490 
Remove the medium, wash twice with 100 µL of 1x DPBS and add 80 µL of 3 µM substrate solution 491 
per well. Keep the no-cell control in William’s E S medium. Save a well without spheroids or 492 
substrate solution for a background control. Incubate for 30-60 min at 37 °C with 5% CO2, 493 
protected from light.  494 
 495 
6.6.4. Equilibrate lyophilized Luciferin Detection Reagent (LDR) using the Reconstitution Buffer 496 
with esterase. Mix by swirling or inverting. Store the appropriated volume at room temperature 497 
until the next step. 498 
 499 
NOTE: Reconstituted LDR can be stored at room temperature for 24 hours or at 4 °C for 1 week 500 
without loss of activity. For long-term storage, store at –20 °C.  501 
 502 
6.6.5. Transfer 25 µL of intact spheroids’ supernatant in three different wells of a white opaque 503 
96-well microplate, after incubation. Add 25 µL of LDR per well and homogenize.  504 
 505 
6.6.6. Incubate the white plate at room temperature for 20 minutes. Read the luminescence on 506 
a luminometer. Do not use a fluorometer. 507 
 508 
6.6.7. Calculate net signals by subtracting background luminescence values (no-cell control) from 509 
the test compound-treated and untreated (vehicle control) values. Calculate percent change of 510 
CYP3A4 activity by dividing the net treated values by the net untreated values and multiplying by 511 
100. 512 
 513 
6.7.  Western blotting 514 
 515 
6.7.1. Transfer the liver spheroids to an identified 1.5 mL microtube. Remove the medium and 516 
wash twice with 100 µL of 1x DPBS.  517 
 518 
6.7.2. Lysate the liver spheroids in 100 µL of cell lysis RIPA buffer at 4 °C for 20 min. Centrifuge 519 
for 15 min, 4 °C, and 11000 rpm. Transfer the supernatant to another identified 1.5 mL 520 
microtube.  521 
 522 
6.7.3. Quantify the amount of protein obtained through the Bradford method. Load between 10 523 
and 50 µg of protein from the quantified cell lysate per well of a gradient polyacrylamide gel 3-524 
15% and perform an SDS-PAGE.  525 
 526 
6.7.4. Transfer the loaded protein from the gel to a 0.22 µm PVDF membrane through the semi-527 
dry system equipment. Use a transference solution of 50 mM Tris-HCl and 192 mM glycine. Set 528 



   

equipment parameters according to the number of gels to be transferred (1 to 2 at a time). 529 
 530 
6.7.5. Block nonspecific interactions on PVDF membrane with a 3-5% skim milk solution in TBS-T 531 
buffer: Tris-Buffered Saline (50 mM Tris pH 7.6, 150 mM sodium chloride) supplemented with 532 
0.1% of Tween 20. Keep the membrane under gently constant shaking for 1 hour at room 533 
temperature.  534 
 535 
6.7.6. Wash with TBS-T under gently constant shaking for 3-5 min at room temperature. Repeat 536 
this washing step twice. 537 
 538 
6.7.7. Dilute albumin and vinculin primary antibodies to 1:1000 and 1:2000 respectively on TBS-539 
T. Incubate the membrane with primary antibodies overnight at 4 °C, under gently constant 540 
shaking. 541 
 542 
NOTE: Always follow the manufacturer’s instructions to dilute antibodies.  543 
 544 
6.7.8. Remove the primary antibody and wash membrane 3 times (step 6.7.6). Dilute ECL anti-545 
mouse IgG secondary antibody to 1:5000 on TBS-T. Incubate the membrane with a secondary 546 
antibody under gently constant shaking for 2 hours at room temperature. 547 
 548 
6.7.9. Remove the secondary antibody and wash the membrane (step 6.7.6). Perform protein 549 
detection using ECL Western Blotting Substrate. Expose the autoradiographic films for 30 s to 30 550 
min. Perform the immunoblotting detection in triplicate. 551 
 552 
REPRESENTATIVE RESULTS: 553 
To perform the PK APAP tests in the 2-OC MPS, the first step is to manufacture the human 554 
intestine and liver equivalents (organoids). They are integrated into the 2-OC microfluidic device 555 
(Figure 1A) 24 h before starting of the PK APAP assay. The next day, the medium is changed, and 556 
the model is exposed to APAP. Figure 1 illustrates the intestine and liver equivalents placed inside 557 
the 2-OC device (Figure 1B) and the APAP PK experiment timecourse (Figure 1C). We performed 558 
a MTT assay, TEER measurements, HCA, real-time PCR, western blotting, histology, and confocal 559 
fluorescence microscopy in 2D culture and 3D organoids to check the tissue’s viability and detect 560 
possible APAP toxic effects. In the confocal fluorescence microscopy images, the intestine 561 
equivalent samples stained with DAPI and Phalloidin (for nuclei and actin respectively) were 562 
presented as a contiguous barrier for the non-treated (Figure 2A) and the 12 µM APAP treated 563 
samples (Figure 2B). As seen in Figure 2C, the MTT assay showed relative cell viability levels above 564 
70%, indicating the absence of relevant cytotoxic effects in response to APAP exposure at 12 µM 565 
concentration33–37. The positive control (100 mM) induced significant cell death (survival below 566 
5%). The Caco-2/HT-29 viability and proper differentiation as well as the intestine equivalent 567 
barrier integrity were verified by TEER evolution during the differentiation period (Figure 2D). 568 
APAP did not cause any alteration in the TEER values as shown in Figure 2E. The expression of 569 
the active sodium-coupled glucose transporters SLC5A1, multidrug resistance transporter MDR1 570 
and sodium-potassium ATPase were analyzed, to verify the APAP treatment impact over cell 571 
barriers formation and basal functionality. As demonstrated in Figure 2F–H, both non-treated 572 



   

and APAP treated intestine equivalents have shown similar expression of SLC5A1 and NaKATPase. 573 
The oral administration of 12 µM APAP induced marked an increase in the MDR1 mRNA levels in 574 
intestines equivalents after 24 h (Figure 2H). We also performed HCA of cell phenotypic changes 575 
by a fluorophore dye mixture for nuclei and mitochondrial mass content. Positive controls were 576 
100 mM APAP and 1% NaOH. Additionally, we analyzed whether 12 µM APAP could induce 577 
cytotoxicity to the 2D Caco-2/HT-29 co-culture. The intestinal cells images acquired with 578 
fluorescence microscopy shown in Figure 2I corroborates the MTT data, which have 579 
demonstrated that 12 µM APAP did not cause significant cytotoxicity in the Caco-2/HT-29 580 
intestinal equivalents. 581 
 582 
The assessment of hepatic spheroids basal viability and the cytotoxicity in response to 2 µM APAP 583 
were done by MTT assay and morphological analyses by confocal fluorescence microscopy, H&E 584 
histology, and HCA assays. As shown in the Figure 3A, according to the MTT assay data, the 2 µM 585 
APAP treatment did not induce relevant cytotoxicity in the Liver 2-OC assembly under both static 586 
and dynamic conditions. The cell viability decreased but remained over 80% for both 12 h and 24 587 
h time-points33–37. The positive control treatments (100 mM APAP and 1% NaOH) induced 588 
significant tissue damages (viability below 10%). Microscopic confocal images indicate the 589 
absence of a necrotic center in the liver spheroids in both basal or APAP treatment conditions, 590 
and no evidence of significant death rates (Figure 3B-C). However, when we analyzed multiple 591 
cellular phenotypic changes following the vehicle or 2 µM APAP administration in the 2D 592 
HepaRG/HHSteC coculture through HCA assay, using 100 mM APAP (C+) as a positive control, 593 
contradictorily to the results of the MTT assay, the hepatic cells demonstrated early cytotoxic 594 
responses to 2 µM APAP treatment (Figure 3D). After 24 h, there was a decrease in the number 595 
of cells, in the nuclear area and an increase in mitochondrial mass. Additionally, a fluorophore 596 
dye cocktail containing Hoechst 33342 and MitoTracker Deep Red was used to stain the 3D 597 
hepatic spheroids (Figure 3J). Fiji software was used to evaluate 3D spherical architecture 598 
homogeneity among several spheroids (Figure 3E–I). The graphic shown in Figure 3E shows the 599 
similarity among liver spheroids total area. The aspect ratio (Figure 3F) around 1 means an 600 
absence of bias during the confection process of the spheroids. The evaluation also indicated that 601 
the majority of the spheroids were roughly rounded (Figure 3G). The evaluation of the 602 
morphology perimeter and cell distribution was done by circularity (Figure 3I) and by solidity 603 
calculation (Figure 3H), respectively. We concluded that the methodology to confectioning the 604 
liver spheroids had generated organoids with a smooth perimeter, compatible with spherical 605 
growth, no biases, or necrosis during the process. 606 
 607 
As demonstrated in Figure 4A-B, the liver spheroids showed a relative basal high level of albumin 608 
and GST mRNA expression respectively, indicating proper basal functionality. Nevertheless, the 609 
2 µM APAP treatment for 24 h induced a decrease in the albumin and the GST mRNA expression 610 
levels, suggesting impairment of liver spheroids functionally at 24 h time point of APAP 611 
treatment.  612 
 613 
The detection of the CYP3A4 and UGT1A1 mRNA expression levels demonstrates the liver 614 
equivalents metabolic capacity. The CYP3A4 mRNA basal level (Figure 4C) was consistent with 615 
previous reports6. The APAP treatment induced a trend for a decrease in both CYP3A4 mRNA and 616 



   

UGT1A1 expression in response to APAP treatment (Figure 4C-D) once again corroborating the 617 
hypothesis of impairment of liver spheroids functionally at 24 h time point of APAP treatment.  618 
 619 
Additionally, experiments of western blotting and in vitro enzymatic activity were performed in 620 
order to analyze the albumin protein expression, as well as, the CYP 3A4 activity in liver 621 
equivalents at basal and at APAP treatment conditions. We found that 2 µM APAP treatment 622 
performed at the Liver 2-OC MPS, induced a reduction in the liver equivalent total albumin 623 
expression at 12 h and 24 h time-points at both static (Figure 4E) and dynamic (Figure 4F) 624 
conditions. On the other hand, liver equivalents samples from dynamic conditions have shown a 625 
trend to show higher levels of protein expression of albumin when compared to the static 626 
conditions (Figure 4G). CYP 3A4 in vitro assay performed at liver equivalents from Liver 2-OC MPS 627 
shown that 2 µM APAP treatment for 12 h or 24 h was capable to induce a robust and significant 628 
impairment of CYP 3A4 activity at both static and dynamic conditions (Figure 4H-I). More 629 
interesting, the presence of media flow (dynamic) has induced a significant improvement of liver 630 
equivalents CYP 3A4 activity levels when compared to conditions in which the liver equivalents 631 
were kept in absence of circulating medium (static conditions) (Figure 4J). 632 
 633 
To find the most sensitive analytical condition regarding HPLC analysis, several parameters were 634 
investigated including the composition of the mobile phase, the type, and concentration of 635 
additives. It was found that acetonitrile gave better chromatogram resolution and appropriate 636 
retention time than methanol. Fast and reproducible separation of APAP was obtained using a 637 
C18 reversed-phase column. The APAP retention time (Rt) value was 9.27 ± 0.19 minutes. 638 
Selectivity for APAP is indicated by the shape and symmetrical resolution of the peak, as well as 639 
by the lack of interfering peaks from the DMEM and Williams cell culture media.  640 
 641 
APAP standard concentrations in DMEM S and Williams E S cell culture media diluted with 642 
ammonium acetate buffer (1:1, v/v) ranging from 0.25 to 100.00 µM were used to build the 643 
calibration curves. The linearity of the method was determined at nine concentration levels. The 644 
data are shown in Table 2 and Table 3. The relationship between APAP concentration and the 645 
peak areas was described by the linear regression equations: y = 16106*x + 3579.8 (R2=1, in 646 
DMEM medium) and y = 16397*x + 2475.1 (R2=1, in Williams medium), in which “x” is APAP 647 
nominal concentration in µM and “y” is the chromatogram peak area of APAP in AU. At the upper 648 
limit of quantification (i.e., 100.00 µM), the percentage deviation and the inter-run variability 649 
values were less than 2.50%. The accuracy and the precision for nine concentration levels, 650 
excluding the 0.50 µM (LLOQ), were within an acceptable range with DEV and C.V. values less 651 
than 7.00% (Table 2 and Table 3).  652 
 653 
The analytical method inter- and intra-run accuracy and precision, at four tested concentrations, 654 
fell within the generally accepted criteria for bioanalytical assays. The reproducibility of the 655 
method was evaluated by analyzing replicates of APAP quality control samples of 0.50 (LLOQ), 656 
4.50, 45.00 and 90.00 µM. The intra-run and inter-run average results are reported in Table 4. 657 
The accuracy and precision of the assay are demonstrated by DEV values ≤ 15.00% and by C.V. 658 
values ≤ 7.00%, respectively.  659 
 660 



   

LOD was determined as the sample whose signal-to-noise ratio (S/N) was just greater than 3 and 661 
corresponded to a 0.25 µM APAP. On the other hand, the LLOQ, estimated with 0.50 µM APAP 662 
samples, displayed S/N ratio equal to 10. Furthermore, we found accuracy values (DEV%) ranging 663 
within ≤ 19.00% of the nominal concentration values. The intra- and inter-run variabilities were 664 
demonstrated by C.V. ≤ 18.77%, as shown in Table 2, Table 3 and Table 4)29,30.  665 
 666 
The APAP PK analyses were performed in three different 2-OC MPS assemblies: 1) Intestine 2-667 
OC, containing the intestine equivalent only; 2) Liver 2-OC, containing the liver spheroids only 668 
and 3) Intestine/Liver 2-OC with both intestinal barrier and liver spheroids. 669 
 670 
For absorption studies, the oral route was mimicked by the administration of 12 µM APAP on the 671 
intestine equivalent apical side. APAP concentrations were measured by HPLC/UV, in the medium 672 
samples, collected from apical and basolateral intestinal equivalents sides, in both static and 673 
dynamic conditions. The APAP kinetics in the medium collected from the apical and basolateral 674 
sides demonstrated that the intestine model was able to absorb the APAP. There was a 675 
progressive APAP concentration decrease in the apical side (Figure 5A) concomitantly to APAP 676 
concentration increase at the intestinal basolateral side (Figure 5B). The maximum 677 
concentrations (Cmax) in the medium was around 2 µM for both static and dynamic conditions, 678 
after 12 h of the administration (Tmax).  679 
 680 
For metabolism studies, the intravenous administration was mimicked by the administration of 681 
2 µM APAP in the medium of the liver compartment. The APAP concentration kinetics in the 682 
media under both static and dynamic conditions indicated that only at the dynamic conditions 683 
the decreases in the APAP concentration could be detected, reaching 0.87 µM APAP 12 h after 2 684 
µM APAP administration (T1/2 = 12 h). The liver equivalents showed minimal metabolic efficiency 685 
under static conditions (Figure 5C). The APAP concentration reached 1.7 µM 12 h after APAP 686 
administration. The integrated, systemic like APAP absorption and metabolism evaluation was 687 
performed in the Intestine/Liver 2-OC model. The APAP was administered over the apical side of 688 
the intestine equivalent, emulating the oral route. Medium samples were collected from both 689 
Intestinal sides and also from the liver compartment. Figure 5D shows the progressive decay of 690 
the APAP concentration at the apical side in both static and dynamic conditions. 691 
 692 
Figure 5E shows distinguishable absorption and metabolism phases. The flow also impacted in 693 
the intestinal absorption. The APAP Cmax in the medium changed from 2 µM on the “Intestine 694 
2-OC” (Figure 5B) assembly to 1.7 µM for the dynamic “Intestine/Liver 2-OC” (Figure 5E). Figure 695 
5F shows a direct comparison between the concentration–time profile of APAP in our dynamic 696 
“Intestine/Liver 2-OC” microphysiological system (red curve and y axis) and a representative 697 
profile obtained in humans after a single oral dose of 1000 mg (black curve and y axis). 698 
 699 
FIGURE AND TABLE LEGENDS:  700 
 701 
Figure 1. Schematic step compilation for PK studies in the 2-OC MPS. A) Schematic drawing of 702 
the 2-OC MPS, showing the intestinal and hepatic human tissue equivalents in bottom-up view. 703 
B) 2-OC MPS photograph with the intestinal and liver equivalents integrated into the device in 704 



   

bottom-up view, with representative optical microscopy images. C) Timeline of tissue equivalents 705 
preparation, APAP treatment, and culture medium collections phases for organoid 706 
manufacturing, and pharmacokinetic and toxicological assessments. This figure has been 707 
modified from Marin et al. Acetaminophen absorption and metabolism in an intestine/liver 708 
microphysiological system. Chem Biol Interact. 299, 59-76 (2019). 709 
 710 
Figure 2. Viability and toxicological assessment of the intestine equivalents. A) Representative 711 
confocal fluorescence microscopy images of non-treated Caco-2/HT-29 cells stained with cell 712 
nuclei and actin filaments fluorescent dye (DAPI and Phalloidin respectively); 63x Magnification, 713 
zoom 2.6. B) Representative confocal fluorescence microscopy images of Caco-2/HT-29 cells 714 
treated with 12 µM APAP for 24 h, stained with nuclei and actin filaments fluorescent dye (DAPI 715 
and Phalloidin respectively); 63x Magnification, zoom 2.6. C) Intestine equivalents viability 716 
evaluation by MTT assay in both static and dynamic conditions. The values represented by the 717 
bars in the graph are percent calculated relative to vehicle control (time-point named as 718 
0)*P<0.05 0 vs treatment. D) TEER evolution during the 21 days of differentiation. *P<0.05 day 1 719 
vs other days. E) TEER values after APAP administration into the Intestine 2-OC MPS under 720 
dynamic conditions. Gene expression in intestines equivalents. Absorption potential of the 721 
intestine barrier and possible effects of 12 µM APAP for 24 h under dynamic condition was 722 
verified by SLC5A1 (F), Na-K-ATPase (G) and MDR1 (H) expression. Values represent the mean ± 723 
SEM of three independent experiments. The result is expressed as a ratio to housekeeping 724 
GAPDH. *P<0.05 vehicle vs APAP. I) Operetta image-based HCA performed by the Columbus® 725 
2.4.0. software. Representative images of 2D intestine co-culture in different time points after 726 
12 µM APAP treatment. Negative controls were medium (0 h) or vehicle (0.5% ethanol). Positive 727 
controls shown here is the 100 mM APAP. This figure has been modified from Marin et al. 728 
Acetaminophen absorption and metabolism in an intestine/liver microphysiological system. 729 
Chem Biol Interact. 299, 59-76 (2019). 730 
 731 
Figure 3. Viability and toxicological assessment of the liver equivalents. A) Liver equivalents 732 
viability evaluation by MTT assay in both static and dynamic conditions. The values represented 733 
by the bars in the graph are percent calculated relative to vehicle control (time-point named as 734 
0) *P<0.05 0 vs treatment. B) Representatives confocal images captured from the vehicle and 2 735 
µM APAP 24 h treated liver spheroids from an inner section. C) Representatives H&E 736 
(hematoxylin and eosin staining) images captured from the vehicle and 2 µM APAP 24 h treated 737 
liver spheroids from an inner section. Scale bar = 50 µm. D) Representative images of 2D liver co-738 
culture in different time points after 2 µM APAP treatment. Samples treated with vehicle and 739 
with 2 µM APAP were considered in these analyses. The fluorophore dye mixture includes 740 
Hoechst for nuclear staining and Mitotracker Deep Red for mitochondria mass staining. Negative 741 
controls were medium (0 h) or vehicle (0.5% ethanol). Positive controls were 100 mM APAP. 742 
Measurements of whole spheroids images captured were performed using Fiji software. E) 743 
Frequency distributions of the area F) aspect ratio, G) roundness, H) solidity, I) circularity. N = 85. 744 
*p < 0,05. J) Representative images of 3D liver spheroids acquired by the Operetta using the LWD 745 
10x objective. This figure has been modified from Marin et al. Acetaminophen absorption and 746 
metabolism in an intestine/liver microphysiological system. Chem Biol Interact. 299, 59-76 747 
(2019). 748 



   

 749 
Figure 4. Liver viability/functionality and possible effects of 2 µM APAP under static and 750 
dynamic conditions over it were verified by gene and protein expression and by enzymatic 751 
activity. A) albumin gene expression. B) GSTA2 gene expression. Liver capability to perform phase 752 
I and phase II metabolism and possible effects of 2 µM APAP for 24 h under dynamic condition 753 
over it were verified by gene expression of CYP3A4 (C) and by UGT1A1 (D) respectively. E) Total 754 
albumin protein expression under static condition. F) Total albumin protein expression under 755 
dynamic conditions. condition. G) Comparative graph illustrating the difference in total albumin 756 
expression in liver equivalents cultivated and treated under static or dynamic conditions. H) CYP 757 
3A4 in vitro enzymatic activity under static conditions. I) CYP 3A4 in vitro enzymatic activity under 758 
dynamic conditions. J) Comparative graph illustrating the difference in CYP 3A4 activity in liver 759 
equivalents cultivated and treated under static or dynamic conditions. Values represent the 760 
mean ± SEM of three independent experiments. The data of gene expression is expressed as a 761 
ratio to housekeeping GAPDH. The data of protein expression is expressed as a ratio to vinculin 762 
protein. *P<0.05 vehicle vs APAP treatment. This figure has been modified from Marin et al. 763 
Acetaminophen absorption and metabolism in an intestine/liver microphysiological system. 764 
Chem Biol Interact. 299, 59-76 (2019). 765 
 766 
Figure 5. Analyzes of APAP pharmacokinetics in 2-OC MPS. APAP absorption profile after 12 µM 767 
APAP administration at the apical side of the Intestine 2-OC MPS preparation. The intestinal 768 
barrier was made of a coculture of Caco-2/HT-29 cell lines (A) Static and dynamic APAP 769 
concentrations in the medium from the apical side (representing the human intestinal lumen 770 
side). (B) Static and dynamic APAP concentrations in the medium from the basolateral side 771 
(representing the human intestinal bloodstream side). *P<0.05 static vs dynamic conditions. C) 772 
APAP metabolism profile in the Liver 2-OC MPS by HepaRG/HHSTeC liver spheroids. Comparison 773 
of static and dynamic conditions after a 2 µM APAP administration into the medium. *P<0.05 0h 774 
vs 6 h, 12 h, and 24 h APAP treatment. APAP absorption and metabolism profile after 12 µM 775 
administration on the intestinal barrier apical side of the Intestine/Liver 2-OC MPS preparation. 776 
This emulates the oral route. The intestinal barrier was made of Caco-2/HT-29 cell lines and the 777 
liver equivalent made of spheroids of HepaRG/HHSTeC cell lines. (D) Intestinal/Liver 2-OC APAP 778 
concentrations in the apical side of the intestinal barrier under static and dynamic conditions. (E) 779 
Intestinal/Liver 2-OC APAP concentrations in the medium under static and dynamic conditions. 780 
*P<0.05 static vs dynamic conditions. (F) Comparison between the concentration–time profile of 781 
APAP in our microphysiological system (red curve and y axis) and a representative profile 782 
obtained in humans after a single oral dose of 1000 mg (black curve and y axis). Data was 783 
extracted from plots using WebPlotDigitizer 4.2 (https://automeris.io/WebPlotDigitizer). This 784 
figure has been modified from Marin et al. Acetaminophen absorption and metabolism in an 785 
intestine/liver microphysiological system. Chem Biol Interact. 299, 59-76 (2019). 786 
 787 
Table 1. Conditions and parameters to be used for HPLC-UV analyses of APAP in culture 788 
medium matrices. 789 
 790 
Table 2. Inter-run variation – accuracy, precision, and linearity of standard curve samples 791 
prepared in a mixture of DMEM medium with 0.10 M ammonium acetate buffer (1:1, v/v) from 792 



   

six separate assays.a 793 
aA linear curve was fitted to the data for a response (APAP) versus theoretical concentration as 794 
described in Experimental. The calculated concentration was derived from reading the response 795 
for each standard sample against the calibration curve. Each entry (assay 1-6) corresponds to the 796 
average value of triplicate analysis. 797 
b SD= Standard deviation. c C.V. (coefficient of variation. precision).  798 
d Accuracy (DEV %) = the deviation of the calculated concentration from the nominal value. 799 
This figure has been modified from Marin et al. Acetaminophen absorption and metabolism in 800 
an intestine/liver microphysiological system. Chem Biol Interact. 299, 59-76 (2019). 801 
 802 
Table 3. Inter-run variation – accuracy, precision, and linearity of standard curve samples 803 
prepared in a mixture of Williams medium with 0.10 M ammonium acetate buffer (1:1, v/v) 804 
from six separate assays.a 805 
aA linear curve was fitted to the data for a response (APAP) versus theoretical concentration as 806 
described in Experimental. The calculated concentration was derived from reading the response 807 
for each standard sample against a calibration curve. Each entry (assay 1-5) corresponds to the 808 
average value of triplicate analysis.b SD= Standard deviation c C.V. (coefficient of variation. 809 
precision). d Accuracy (DEV %) = the deviation of the calculated concentration from the nominal 810 
value. This figure has been modified from Marin et al. Acetaminophen absorption and 811 
metabolism in an intestine/liver microphysiological system. Chem Biol Interact. 299, 59-76 812 
(2019). 813 
 814 
Table 4. Intra- and inter-run precision and accuracy for APAP in quality control samples.a 815 
aThe data are shown as averages. SD (standard deviation). C.V. (coefficient of variation. precision) 816 
and accuracy (percent deviation. DEV%). This figure has been modified from Marin et al. 817 
Acetaminophen absorption and metabolism in an intestine/liver microphysiological system. 818 
Chem Biol Interact. 299, 59-76 (2019). 819 
 820 
Table 5. Real-time qPCR primers to evaluate gene transcription at mRNA level in the 2-OC 821 
cultures for intestine and liver tissues 822 
 823 
DISCUSSION:  824 
The accurate and reliable assessment of the pharmacologic properties of investigative new drugs 825 
is critical for reducing the risk in the following development steps. The MPS is a relatively new 826 
technology, that aims at improving the predictive power and reducing the costs and time spent 827 
with preclinical tests. Our group is advancing in the assessment of pharmacokinetic and 828 
toxicological properties mostly needed for lead optimization. We worked with the 2-OC 829 
microfluidic device, which has two chambers, allowing the integration of two organoids. APAP 830 
was chosen because it has plenty of high-quality human data, is mostly metabolized by the liver, 831 
and also displays hepatotoxic properties. The study protocol aimed to emulate some steps of the 832 
human phase I clinical trial, where a drug is administered orally to volunteers, and periodic blood 833 
samples are drawn to assess the drugs’ concentration to know the pharmacokinetic properties 834 
and biochemical and clinical parameters are collected to assess the safety and tolerability. 835 
Therefore, when the MPS evolves enough to provide reliable predictions, it will significantly 836 



   

reduce the risk of failure in the phase I trial. By adding the disease models in the future, the same 837 
assumption possibly will apply to the phases II and III clinical trials.  838 
 839 
All studies were performed in three models: Intestine 2-OC (APAP oral administration), Liver 2-840 
OC (Intravenous administration), and Intestine/Liver 2-OC (oral administration). The first model 841 
isolated the absorption, the second the metabolism, and the third integrated both. We first 842 
produced the organoids and incorporated into the microfluidic device, second administered the 843 
APAP and collected the media samples, and last performed a set of tests to assess the cell viability 844 
and functionality and the toxicological impact of APAP exposure. For the pharmacokinetic 845 
studies, we developed and validated a chromatographic method for APAP quantification in the 846 
medium. The validation complied with the Guideline on Bioanalytical Method Validation 847 
regarding specificity, linearity, the limit of quantification (LOQ), the limit of detection (LOD), 848 
matrix effect, precision, and accuracy, as outlined by FDA29,30. The specificity was established with 849 
blank, pooled, and individual biological samples from two different sources. The method 850 
performed acceptably during the analysis, and the data confirmed the ability of a simple isocratic 851 
mobile phase to separate and quantify APAP.  852 
 853 
The viability/functionally of the intestine and liver organoids was assessed by different 854 
techniques. For the intestine equivalent, the confocal fluorescence microscopy (Figure 2A-B), the 855 
MTT assay (Figure 2C), gene expression assessment (Figure 2D-F) or HCA experiment, did not 856 
detect any toxicity 24 h after APAP exposure. Likewise, MTT assay did not detect toxic insults 857 
induced by APAP in liver equivalents (Figure 3A). However, the HCA technique added the 858 
possibility of detection of very early toxic events (24 h after APAP exposure) for liver cells, by the 859 
observation of cell phenotypic changes, with some mechanistic clues (Figure 3D). On the other 860 
hand, the confocal fluorescence microscopy (Figure 3B) and histology (Figure 3C) were showed 861 
to be a useful complementary tool in the investigation of the viability status of the human tissue’s 862 
equivalents. For the liver cells, the simultaneous use of different techniques was very 863 
advantageous. The MTT assay, as mentioned before, was not able to detect the APAP cytotoxicity 864 
detected by the HCA 24 h after APAP exposure. The gene expression analyses assessed the 865 
functionality of the intestine (Figure 2D-F) and liver organoids (Figure 4A-D) at both basal and 24 866 
h after APAP treatment. Under basal conditions, there were normal levels of intestinal and liver-867 
specific markers, suggesting proper functionality. After 24 h of APAP exposure, there was a 868 
downregulation of albumin, GST mRNA levels, and a tendency to reduce the CYP3A4 gene 869 
expression in liver equivalent tissues, indicating APAP early cytotoxicity. Corroborating these 870 
findings, Western blotting experiments showed that the reduction in gene expression was also 871 
accompanied by a robust reduction in liver total albumin protein expression in response to APAP 872 
treatment (Figure 4E-F), confirming the toxic insults imposed on liver tissue by exposure to APAP. 873 
Accordingly, experiments of in vitro enzymatic activity showed a robust and progressive 874 
reduction in CYP 3A4 activity levels induced by APAP treatment, in liver equivalents (Figure 4H-875 
I). 876 
 877 
Morphometrical statistics of organoids were performed on Image J (Figure 3E-I). The area reveals 878 
how close the 2D size is to all organoids analyzed, which could be used as standardization in this 879 
protocol so that an unbiased result can be produced. The ‘shape descriptors’ reveal statistics 880 



   

corresponding precisely to the shape morphology. The Aspect Ratio is an index which uses the 881 
major and minor axis, so results around 1 indicate no bias (i.e., preferential growth) during 882 
organoid formation. Values of Roundness (4 ×[area]/ (π × [major axis]2)) are very sensitive to a 883 
preferential growth, which would be revealed as a major axis. Solidity ([area]/ ([convex area])) is 884 
essential in showing gross morphology as it is not affected by irregularities in borders since it 885 
uses convex area (=envelope). Distributions centered around 1.0 indicate putative spherical 886 
growth. Conversely, Circularity (4× π [area]/[perimeter]2) is very sensitive to a complex 887 
perimeter, so “cavities” or “pockets” would impact this index. Thus, circularity around 1 also 888 
corroborates putative spherical growth, compatible with proper organoid functionality. 889 
 890 
The analytical results showed that the MPS could emulate the APAP absorption and metabolism 891 
properties, both isolated or integrated in a curve comparable to that produced in vivo (Figure 5F) 892 
without the excretion phase. The APAP absorption was similar after oral administration to both 893 
Intestine MPS or Intestine/Liver MPS models, under both static and dynamic conditions (Figure 894 
5A-B, Figure 5D-E). In both, there was an APAP concentration decreases at apical side 895 
concomitantly to its increase at the basolateral side, with no significant difference for static and 896 
dynamic conditions. In contrast, the APAP hepatic metabolism differed under these conditions. 897 
The circulating media in MPS seemed to improve the organoid metabolic capability (Figure 5C 898 
and Figure 5E). There was a significant APAP decay underflow not seen without flow. 899 
Interestingly, in vitro, CYP3A4 activity experiments corroborate the hypothesis that the presence 900 
of flow in the system increases the functionality of human liver equivalents. As shown in the 901 
graph in Figure 4J, the activity of CYP 3A4 was significantly higher in liver equivalents maintained 902 
under flow at both basal and APAP treatment conditions. Likewise, the liver equivalents kept 903 
under flow (dynamic) showed a tendency to increase the protein expression of albumin when 904 
compared to those kept without flow (static) both at baseline or at APAP treated conditions 905 
(Figure 4G).  906 
 907 
When compared to the concentration-time profile after oral administration of APAP to humans, 908 
our microphysiological system shows much larger t1/2 (half-life time) (Figure 5F). This happens, as 909 
mentioned before, because while we have a two-organ system with intestine and liver 910 
equivalents that can absorb and metabolize the drug, there is no kidney equivalent to excrete 911 
APAP and its metabolites from the plasma compartment38. In addition to that, the 912 
microphysiological system shows smaller Cmax (peak plasma concentration) and larger tmax 913 
(time to reach Cmax) than what is typically observed for humans (Figure 5F). This is a 914 
consequence of the differences in the scale of the in vitro and in vivo experiments. Overall, there 915 
are three main differences between the concentration–time profile obtained using the 916 
microphysiological system and profiles obtained after oral administration of APAP to humans: 917 
larger t1/2, smaller Cmax and larger tmax (Figure 5F). While the larger t1/2 is due to the absence of a 918 
kidney equivalent to excrete APAP and its metabolites from the plasma equivalent, smaller Cmax 919 
and larger tmax are consequences of the small scale of the experiment when compared to the 920 
human body. The best scaling strategies for building and operating microphysiological systems 921 
are still an active area of research and it is unlikely that a single approach is optimal for all 922 
systems39. Additionally, mathematical modeling or machine learning can be used to apply 923 
corrections or learn the mapping from the micro scale to full scale in order to extrapolate in vitro 924 



   

data obtained with the microphysiological systems to the in vivo behavior observed in humans40. 925 
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HPLC system

Detector

System control, data 

acquisition, and processing

Time

(min.)

15 5 95

Flow

Injection volume

Temperature

APAP Detection

Run time

Waters Alliance 2695 (Milford, MA, USA), equipped with quaternary 

Waters 2996 Uv-Vis set in 210-400 nm range

Waters Empower 2002 chromatography software

Column

Reversed-phase Luna C18 

(150 x 4.6 mm I.D.; 5mm particle size)

Phenomenex

Guard Column
Reversed-phase Luna C18 (4 x 3 mm)

Phenomenex

Mobile phase

Solvent A- Acetonitrile

Solvent B- 0.10 M ammonium acetate, pH 6.8

15 minutes

Isocratic conditions
A (%) B (%)

1.0 mL/min

25 mL

25 °C

UV @ 243 and 254 nm
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Nominal concentration S.D.b C.V. DEV

(µM) (µM) (%)c (%)d

Assay number 1 2 3 4 5 6

0.25 (LOD) 0.02 0.08 0.21 0.14 0.08 0.27 0.13 0.11 84.96 + 46.05

0.50 (LLOQ) 0.31 0.36 0.29 0.47 0.42 0.65 0.41 0.05 12.72 + 17.08

1.00 0.87 0.87 0.80 1.04 1.02 1.01 0.93 0.04 3.76 + 6.65

2.50 2.44 2.61 2.52 2.42 2.56 2.54 2.52 0.04 1.54 -0.62

5.00 5.02 4.99 5.06 5.01 5.01 5.05 5.02 0.09 1.88 -0.45

10.00 10.21 10.13 9.96 10.25 10.08 10.21 10.14 0.10 0.97 -1.41

25.00 25.33 25.28 25.20 25.13 25.14 24.92 25.17 0.36 1.45 -0.67

50.00 50.30 50.04 50.51 49.70 49.98 49.19 49.95 0.86 1.71 +0.09

100.00 99.75 99.90 99.70 100.09 99.97 100.40 99.97 0.69 0.69 +0.03

R2 1.00 1.00 0.9999 1.00 1.00 0.9999

Calculated APAP concentration (µM)

(triplicate of each concentration)

Average 

(µM)
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Nominal concentration Average S.D.b C.V. DEV

(µM) (µM) (µM) (%)c (%)d

Assay number 1 2 3 4 5

0.25 (LOD) 0.34 0.12 0.30 0.16 0.00 0.18 0.08 45.46 +26.03

0.50 (LLOQ) 0.36 0.44 0.49 0.43 0.40 0.43 0.02 5.84 +14.97

1.00 0.87 0.98 1.04 0.94 0.83 0.93 0.04 4.67 +6.85

2.50 2.41 2.46 2.49 2.52 2.43 2.46 0.06 2.39 +1.56

5.00 5.00 4.99 5.12 5.10 5.14 5.07 0.15 3.00 -1.38

10.00 10.08 10.01 9.93 10.10 10.29 10.08 0.18 1.80 -0.81

25.00 25.14 25.18 24.96 25.32 25.35 25.19 0.45 1.78 -0.76

50.00 50.19 50.23 49.83 49.56 50.17 49.99 0.87 1.75 +0.01

100.00 99.87 99.84 100.10 100.13 99.80 99.95 2.12 2.12 +0.05

R2 1.00 1.00 1.00 1.00 1.00

Calculated APAP concentration (µM)

(Triplicate of each concentration)
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Nominal concentration Measured concentration S.D. C.V. DEV

(µM) (µM) (µM) (%)  (%)

Intra-run (n=3) 0.50 (LLOQ) 0.49 0.08 15.55 +1.77

4.50 4.59 0.23 5.10 -2.06

45.00 41.23 0.76 1.85 +8.37

90.00 82.29 1.75 2.13 +8.57

Inter-run (n=15) 0.50 (LLOQ) 0.43 0.05 10.99 +14.97

4.50 4.37 0.19 4.42 +2.99

45.00 42.35 0.82 1.93 +5.88

90.00 85.22 2.25 2.65 +5.31

Nominal concentration Measured concentration S.D. C.V. DEV

(µM) (µM) (µM) (%)  (%)

Intra-run (n=3) 0.50 (LLOQ) 0.47 0.09 18.77 +6.35

4.50 4.45 0.30 6.63 +1.04

45.00 44.24 1.59 3.58 +1.69

90.00 86.40 4.09 4.73 +4.00

Inter-run (n=12) 0.50 (LLOQ) 0.46 0.08 17.81 +7.75

4.50 5.16 0.27 5.31 -14.68

45.00 48.99 2.10 4.29 -8.86

90.00 96.18 4.47 4.65 -6.86

DMEM medium

Williams medium
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Tissue Gene Forward Reverse

SGLT1/SLC5A1 gAgCCCAgCAACTgTCCCAC CAggCTCCAACACAgACggT

NA-K-ATPase ACCgCCCAgAAATCCCAAAAC CAgCggTCATCCCAgTCC

MDR1 TggATgTTTCCggTTTggAg TgTgggCTgCTgATATTTTgg

Albumin TgCAAggCTgATAAggAg TTTAgACAgggTgTTggCTTTACAC

GSTA2 CTgAggAACAAgATgCCAAgC AgCAgAgggAAggCTggAAATAAg

CPY3A4 ggAAggTggACCCAgAAACTgC TTACggTgCCATCCCTTgAC

UGT1A1 ATgCAAAgCgCATggAgAC ggTCCTTgTgAAggCTggAg

Primer (5’ → 3’) 

Intestine

Liver

Table 5 Click here to access/download;Table;table 5.xlsx

https://www.editorialmanager.com/jove/download.aspx?id=1239046&guid=62ab9ec5-aee3-440c-9e38-2bc1a67f2a49&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1239046&guid=62ab9ec5-aee3-440c-9e38-2bc1a67f2a49&scheme=1


Name of Material/ Equipment Company Catalog Number Comments

1x DPBS Thermo Fisher Scientific 14190235 No calcium, no magnesium

2-OC TissUse GmbH Two-organ chip

384-well Spheroid Microplate Corning 3830
Black/Clear, Round Bottom, Ultra-Low 

Attachment

4% Paraformaldehyde Use to fix cell

Acetaminophen Sigma Aldrich A7085 Use to MPS assays

Acetonitrile Tedia Used to perform HPLC

Alexa Fluor 647 phalloidin Thermo Fisher Scientific confocal experiment

Ammonium acetate Sigma Aldrich Used to perform HPLC

Caco-2 cells Sigma Aldrich 86010202

Cacodylate buffer

Cell culture flasks Sarstedt

Confocal Fluorescence 

microscope
Leica DMI6000

Cryostat Leica CM1950

DMEM high glucose Thermo Fisher Scientific 12800017

Add supplements:  10% fetal bovine serum, 

100 units per mL penicillin, 100 µg/mL 

streptomycin, and 1% non-essential amino 

acids

DMSO Sigma Aldrich D4540 Add 2% to HepaRG media

Ethanol Synth

Fetal Bovine Serum Thermo Fisher Scientific 12657029

Freezing medium OCT Tissue-Tek

Tissue-Tek® O.C.T.™ Compound is a 

formulation of watersoluble glycols and 

resins, providing a convenient specimen 

matrix for cryostat sectioning at 

temperatures of -10°C and below.

Hematoxylin & Eosin

HepaRG cells Biopredic International HPR101 Undifferentiated cells

HHSTeC ScienCell Research Laboratories 5300 Cells and all culture supplements

Hoechst 33342 HCA experiments
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HT-29 cells Sigma Aldrich 85061109

Human Insulin Invitrogen - Thermo Fisher Scientific 12585014

Hydrocortisone Sigma Aldrich H0888

Isopropanol Merck 278475

Karnovsky’s fixative

L-glutamine Thermo Fisher Scientific A2916801

Luna C18 guard column SS Phenomenex Used to perform HPLC

Microscope Leica DMi4000

Microtome Leica RM2245

Millicell 0.4 µm pore size inserts Merck PIHP01250

Millicell ERS-2 meter Merck MERS00002 Used to TEER measurement

MitoTracker Deep Red HCA experiments

MTT Thermo Fisher Scientific M6494

MX3000P system Agilent Technologies

Neubauer chamber Counting cells

Operetta High Content Imaging 

System
Perkin Elmer Used to perform HCA

P450-Glo CYP3A4 Assay with 

Luciferin-IPA 
Promega Cat.# V9001

Penicillin/Streptomycin Thermo Fisher Scientific 15070063 Cell culture

Permount Thermo Fisher Scientific Histology

Primers RT-qPCR

PVDF membrane BioRad

PVDF Syringe filter 0.22 μm pore size

Reversed-phase Luna C18 column Phenomenex Used to perform HPLC

Shaker (IKA VXR Basic Vibrax) IKA Works GmbH & Co 2819000 Used for spheroids to improve MTT assay

Stellate Cell Media (STeC CM) ScienCell 5301 Add STeC CM supplements 



SuperScriptIITM Reverse 

Transcriptase
Thermo Fisher Scientific

SYBR Green PCR Master Mix Thermo Fisher Scientific

TRizol TM reagent Thermo Fisher Scientific
Trizol is a monophasic solution of phenol and 

guanidine isothiocyanate.

Trypsin/EDTA solution Thermo Fisher Scientific R001100

Ultra-low-attachment plates Corning CLS3471-24EA 6 wells

Vectashield plus DAPI mounting 

media

White Opaque 96-well 

Microplate 
PerkinHelmer

Wide-bore tips

Williams E Pan Biotech P04-29510

Add supplements: 10% fetal bovine serum, 2 

mM L-glutamine, 100 units per ml penicillin, 

100 µg/mL streptomycin and 5 µg/mL human 

insulin
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Dear Editor and Reviewers, 
 
Below are the answers (in blue) to the doubts, questions and suggestions made by you. 
The authors are very grateful for the careful review of this manuscript. 
Sincerely yours, 
 
Talita Miguel Marin 
 
Editorial comments: 
Changes to be made by the Author(s): 
1. Please take this opportunity to thoroughly proofread the manuscript to ensure that 
there are no spelling or grammar issues. The JoVE editor will not copy-edit your 
manuscript and any errors in the submitted revision may be present in the published 
version. 
2. We can only have 6-12 keywords. Modification performed. 
3. Please rephrase the Long Abstract to more clearly state the goal of the protocol. 
Modification performed. 
4. Please remove all commercial language from your manuscript and use generic terms 
instead. All commercial products should be sufficiently referenced in the Table of 
Materials and Reagents. Modification performed. 
For example: TissUse GmbH (2-OC)), Millicell ERS-2 meter, Leica CM1950 cryostat, 
Permount, Evotec/PerkinElmer Opera Flex, Operetta High Content 573 Imaging System, 
TRizol TM reagent, SuperScriptIITM Reverse Transcriptase, SYBR Green PCR Master Mix, 
etc. 
5. Unfortunately, there are a few sections of the manuscript that show significant 
overlap with previously published work. Though there may be a limited number of ways 
to describe a technique, please use original language throughout the manuscript. Please 
see lines: 113-115, 118-119, 158-160, 162-163, 168-175, 205-206, 248-250, 252-258, 
282-283, 285-287, 295-299, 352-382, 405-407, 416-417, 427-430, 448-457, 470-490673-
674, 743-744. Modification performed. 
6. Please ensure the Introduction includes all of the following with citations: 
a) A clear statement of the overall goal of this method 
b) The rationale behind the development and/or use of this technique 
c) The advantages over alternative techniques with applicable references to previous 
studies 
d) A description of the context of the technique in the wider body of literature 
e) Information to help readers to determine whether the method is appropriate for their 
application 
7. Please ensure that all text in the protocol section is written in the imperative tense as 
if telling someone how to do the technique (e.g., “Do this,” “Ensure that,” etc.). The 
actions should be described in the imperative tense in complete sentences wherever 
possible. Avoid usage of phrases such as “could be,” “should be,” and “would be” 
throughout the Protocol. Any text that cannot be written in the imperative tense may 
be added as a “Note.” However, notes should be concise and used sparingly. 
Modification performed. 
8. The Protocol should contain only action items that direct the reader to do something. 
ok 
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9. The Protocol should be made up almost entirely of discrete steps without large 
paragraphs of text between sections. Please ensure that individual steps of the protocol 
should only contain 2-3 actions per step. ok 
10. Please ensure you answer the “how” question, i.e., how is the step performed? 
11. How do you check for tight monolayer formation? How do you change the media?  
ANSWER FROM AUTHORS: The tight monolayer formation was verified by measuring 
TEER (transepithelial electrical resistance) every three days using a voltmeter, as 
described in Protocol section 1.1.6. Additionally, confocal fluorescence microscopy 
images of non-treated Caco-2/HT-29 cells stained with cell nuclei and actin filaments 
fluorescent dye (DAPI and Phalloidin respectively) indicated the formation of a 
contiguous barrier (Fig. 2 A). The media is change as described at Protocol section 1.1.5 
“ Change the medium at least three times a week, aspirating it from both the apical and 
basolateral sides with a sterile Pasteur pipette, taking care not to damage the intact cell 
barrier. NOTE: Proceed with the aspiration on the apical side, so as not to touch the cell 
barrier (aspirate by supporting the Pasteur pipette on the plastic rim of the cell insert).” 
12. Please include a citation or include how to perform these steps?  
ANSWER FROM AUTHORS: Modification performed – Inclusion were done ate Protocol 
section 1.1.5 and 1.1.6. 
13. How is the resistance measurement performed?  
ANSWER FROM AUTHORS: According to the description inserted in this review in the 
protocols section 1.1.6: “Check the tight monolayer formation, measuring TEER 
(transepithelial electrical resistance) every three days using a voltmeter22, according to 
the manufacturer's instructions. Perform a blank, measuring the resistance across a cell 
culture insert without cells, but with the same cell medium and at the same cell plate. 
Calculate tissue resistance, subtracting the blank resistance from the tissue equivalent 
resistance, and multiply by the effective surface area of the filter membrane (0.6 cm2). 
A good intestine barrier resistance is in a range of 150 to 400 Ωcm2.NOTE: After 21 days 
the cells must be fully differentiated, the intestinal barrier formed, so the intestine 
equivalents are ready to be integrated into MPS.” 
14. The current protocol is longer than our limit for the protocol section. There is a 10-
page limit for the Protocol, but there is a 2.75-page limit for filmable content along with 
the formatting done as of now. Please highlight 2.75 pages or less of the Protocol 
(including headings and spacing) that identifies the essential steps of the protocol for 
the video, i.e., the steps that should be visualized to tell the most cohesive story of the 
Protocol. ok 
15. Please remove the embedded table of materials - Modification performed. 
- and upload it as .xlsx file to your editorial manager account. Please sort the materials 
table alphabetically. Please remove trademark (™) and registered (®) symbols from the 
Table of Equipment and Materials. OK 
16. Please obtain explicit copyright permission to reuse any figures from a previous 
publication. Explicit permission can be expressed in the form of a letter from the editor 
or a link to the editorial policy that allows re-prints. Please upload this information as a 
.doc or .docx file to your Editorial Manager account. ok 
The Figure must be cited appropriately in the Figure Legend, i.e. “This figure has been 
modified from [citation].” Modification performed. 
17. As we are a methods journal, please revise the Discussion to explicitly cover the 
following in detail in 3-6 paragraphs with citations: 



a) Critical steps within the protocol 
b) Any modifications and troubleshooting of the technique 
c) Any limitations of the technique 
d) The significance with respect to existing methods 
e) Any future applications of the technique 
18. Please ensure that the references appear as the following: [Lastname, F.I., LastName, 
F.I., LastName, F.I. Article Title. Source. Volume (Issue), FirstPage – LastPage, (YEAR).] 
For more than 6 authors, list only the first author then et al. 
19. Please include a scale bar for all the images acquired with a microscope. OK 
20. Please change hours to h, minutes to min and seconds to s in the figures. Also please 
include a singly space between the number and the units. Modification performed. 
Reviewers' comments: 
Reviewer #1: 
Manuscript Summary: 
Marin et al demonstrate the feasibility of in line connection of two critical organs 
utilizing a microphysiological systems approach and acetaminophen as a test agent. The 
authors clearly lay out the need for development of techniques to couple MPS to mimic 
the metabolism of drugs and communication of such events to distal organs. The 
approach is justified and timely as researchers seek alternatives to small animal models. 
The protocol was written in sufficient detail to easily follow. Validation experiments 
were provided that convincingly showed the utility of the system. 
 
Major Concerns: 
None 
 
Minor Concerns: 
Editing of the verbiage would help clarify some areas of the manuscript. Additionally, 
Figure 1 appears quite blurry, upgrade the graphics. 
Ans: Modification performed. 
Reviewer #2: 
Manuscript Summary: 
This manuscript describes a microfluidic system forming intestinal and hepatic crosstalk. 
The intestinal system is composed of a Caco-2 and HT-29 co-culture whereas the hepatic 
portion is composed of HepaRG and human hepatic stellate cell liver spheroids. This 
group assessed toxicity and viability in the intestinal system and hepatic system 
separately by using acetaminophen at 12 μM to simulate oral administration of drug, 
and 2 μM to simulate intravenous administration. Some important revisions are needed 
prior to publication as described below. 
 
Major Concerns: 
1. The investigators administer 12 μM of acetaminophen as an oral dose, but 2 μM as 
an intravenous dose. While this would perhaps be physiologically correct for 
administration, it is unclear that this model has the capability of exhibiting first pass 
metabolism which would be responsible for reducing the oral bioavailability of a drug to 
more closely resemble a clinical intravenous dose. 
ANSWER FROM AUTHORS: The dilution of 200 µL of culture medium at 12 µM APAP 
concentration (applied to the apical side of the intestinal barrier - 4.1. APAP “oral” 



administration and media sampling, methods section)) in the total volume of MPS, 
which is 1000 µl,  is the cause of the difference between the concentration of orally 
administered APAP (12 uM) and the systemically APAP (2 uM) verified concentration 
after full intestinal absorption. The total volume of the microfluidic device is 1000ul 
counting the apical side of the intestinal barrier (200ul), the basolateral side (500ul), and 
the liver compartment (300ul). 
 Finally, why were these concentrations chosen? Do they resemble physiologic values or 
were they picked arbitrarily?  
ANSWER FROM AUTHORS: During the standardization phase of the pharmacokinetic 
tests, different conditions including the appropriate concentrations of APAP treatment 
were tested. Regarding the liver equivalents APAP  metabolization testes, when we used 
concentrations greater than 10µM APAP, it was not possible to verify the significant drop 
in the APAP concentration. This was probably due to the saturation of the metabolic 
capacity of the liver cells and initial toxic effects in 24h time point (that even occurred 
with 2µM APAP) exactly where the half-life of the drug occurs and then where the toxic 
metabolite NAPIQ has better chance to be present. In this way, we had to find, 
empirically, the optimal concentration of APAP, which means, a minimum concentration 
and above the limit of quantification set to the HPLC method and with fewer chances of 
overloading the liver cell's metabolic capacity. This concentration was set up at 2  μM. 
As a consequence, the concentration of choice for treatment of the intestines was 12 
μM (when the intestines were treated on the apical side with 12 μM, the resulting 
systemic concentration verified by HPLC was 2 μM. 
2. The manuscript initially states that acetaminophen never induces cytotoxicity, which 
runs counter to common knowledge (acetaminophen is a liver toxin in an overdose 
scenario); however, the manuscript later states that the 2 μM dose of acetaminophen 
did initially cause cytotoxicity based on a decrease in the number of cells, a decrease in 
nuclear area, and an increase in mitochondrial mass. From this contradiction, it is not 
clear how the authors constitute drug toxicity in their model and therefore a revised 
explanation is warranted. 
ANSWER FROM AUTHORS:  
we appreciate the comment and respectfully disagree. At the beginning of the 
manuscript, in the abstract, last paragraph we affirm: “The MTT technique performed 
well in assessing the organoid viability, but the High Content Analyzes (HCA) was able to 
detect very early toxic events. We verified that the medium flow does not importantly 
affect the APAP absorption whereas it improves significantly the hepatic metabolism ”. 
We include "in response to APAP treatment" after "early toxic events" to make the 
statement meaning clear. The present manuscript was based on the published 
manuscript “Acetaminophen absorption and metabolism in an intestine/liver 
microphysiological system” Chem Biol Interact. 2019 Feb 1; 299: 59-76. doi: 10.1016 / 
j.cbi.2018.11.010 ”in which the possible toxic well-known effects of APAP over the liver 
cells, are widely discussed based on literature information and data from the above-
referred article. Specifically for Jove, following the journal's instructions, this part was 
removed from the introduction to reduce the text size and focus on the methods. In 
order to clarify to the reviewer, the present manuscript claims to have no evidence of 
toxicity in response to APAP in intestinal cells. Already in liver cells, very early toxic 
effects were observed as described in different parts of the Results section.  We claim 
to find initial toxic responses to APAP treatment in liver cells even at concentrations 



lower than those reported as toxic in the literature (5-10 mM APAP), for cultured liver 
cells. Moreover, we clearly pointed out, in this manuscript of methods, the importance 
of the simultaneous use of different methodologies and the scientific gains that they can 
bring, as in the case of the present study in which the HCA and Real-time PCR were able 
to detect cellular responses to toxic insults not detected by the MTT or microscopy 
assay. Corroborating our toxicity finds in response to APAP treatment in liver cells, a new 
data set from analysis of albumin expression and CYP 3A4 activity were included in the 
present study. 
3. There was no functional characterization of the various cell types. The only assays 
they used to assess function were viability and gene expression. For example, an 
assessment of albumin and drug metabolism capacity (e.g. CYP3A4 activity) for the 
HepaRG would be an accurate functional assay. 
ANSWER FROM AUTHORS: We thank you for the relevant comment. We have included 
a new data set from experiments of analyses of albumin protein expression and CYP 3A4  
in vitro activity (Figure 4 E-J), as well as,  the new data Results description and Discussion.  
4. Please justify the use of stellate cells over other liver nonparenchymal cells. 
ANSWER FROM AUTHORS: The liver model adopted in the present study was based on 
previous work by the Uwe Marx group, based on the co-culture of HEPA RG and HHSteC 
cells [1]. Furthermore, because the Human Hepatic stellate cells (HHSteC) are 
intralobular connective tissue cells presenting myofibroblast-like or lipocyte 
phenotypes, they participate in the homeostasis of liver extracellular matrix, repair, 
regeneration, fibrosis and control retinol metabolism, storage and release. Following 
liver injury, HHSteC transforms into myofibroblast-like cells and is the major source of 
type I collagen in the fibrotic liver. Beyond these features, HHSteC has been implicated 
as regulators of hepatic microcirculation via cell contraction, and in disease states, in the 
pathogenesis of intrahepatic portal hypertension [2,3], thus being important for proper 
possible toxicological responses induced by pharmacological injury for example. 
Furthermore, in our hands, the inclusion of HHSteC cells have shown to be necessary for 
the proper spheroid formation.  
5. Is the system capable of longer-term toxicity results for a more physiologic model? 
The current data only represents one day of toxicity which is not completely relevant for 
clinically dosed compounds. 
ANSWER FROM AUTHORS: We thank the reviewer for the comment. According to 
several previous studies [4,5], this system is compatible with long-term studies. 
Regarding the present study, it lasted only 24 hours for the reason of the appearance of 
the early toxic responses induced by APAP treatment, which made the liver tissue 
unviable and non-functional after 24 h of APAP exposure. From our perspective, this 
finding is relevant because it demonstrates that the adopted microphysiological system 
can identify that APAP can have deleterious effects on liver tissue in low concentrations 
and in a short-term treatment period, pointing out the necessity of technic and process 
optimization, as well as the adoption of more discerning and accurate toxicological 
assessment. 
Minor Concerns: 
1. In figure 2c and 3a, are these values percent of vehicle control, non-treated cultures, 
or cells at time point 0? This should be clarified. Most likely it should be percent of 
vehicle control. ANSWER FROM AUTHORS: We performed the alteration required. The 
details have been inserted in the caption of figures 2 and 3. 



2. With regards to the figures, the letter subsets are not uniformly placed. For example, 
in Figure 3, some of the letters are above their respective figure subset and others are 
below it which makes it difficult to properly interpret the figure.  
ANSWER FROM AUTHORS: We performed the alteration required 
 
3. Figure 4 depicts HPLC confirmation that the acetaminophen is in fact in their media. 
This is redundant and unnecessary to confirm that the drug is actually being 
administered if they are physically doing so. We recommend that this figure be removed 
and simply discussed.  
ANSWER FROM AUTHORS: Figure withdrew. 
 
4. There is an "F" in Figure 3 that appears to be unintentional.  
ANSWER FROM AUTHORS: Thank you for point it out. We performed the correction. 
5. The manuscript claims that their study imitates a human phase I clinical trial. Please 
temper this claim as a phase I clinical trial involves all the organs in a human body, not 
just liver-intestine crosstalk.  
ANSWER FROM AUTHORS: We performed the alteration required 
6. There are a number of grammatical errors for example in lines 58-59.  
ANSWER FROM AUTHORS: Thank you for point it out. We performed the correction. 
 
Reviewer #3:  
Major Concerns: 
The APAP concentrations tested were 12 and 2 mikro molar. This is considerably lower 
than considered to be toxic concentrations in vivo (above 1 mM). Thus the relevance of 
the any "toxic" responses in the study can be questioned. 
ANSWER FROM AUTHORS:  as the reviewer commented, we really did not expect to find 
any cellular changes in response to a possibly toxic insult induced by APAP treatment. 
However, when conducting viability and functionality tests as data quality control we 
were able to find cellular toxic responses. it was very interesting because the new 
system after 12h "saturated" or the liver was no longer able to metabolize APAP. This 
reduction in the metabolization performance probably is due to the change in the 
chemical balance between APAP and metabolites within a closed system without a 
mechanism of excretion and purification (kidneys), but it can also be due to a direct toxic 
insult (probably caused by this very accumulation of metabolites with potential toxic 
(NAPQI). In addition to the cellular toxic responses findings in the HCA assay and the 
real-time PCR, a new set of data from new experiments corroborated the occurrence of 
liver toxicity in response to the treatment of 2uM APAP. We found that treatment with 
APAP robustly reduces the expression of albumin ( viability and functionality marker in 
liver cells) and also induced impairment of CYP 3A4 activity levels in vitro. Regarding the 
intestines cells treated with 12uM APAP we did not find any toxic effect or deleterious 
cellular response as expected. Thus, we consider the toxicological analyzes relevant and 
appropriate to the present article with a focus on the methods, as it highlights the 
importance of the careful and adequate choice of tests as well as the combination of 
various techniques in trials with the same outcome as objective 
 



Also there is little or no information whether the solvent concentrations are the same 
when different concentrations of APAP is tested. E.g. the toxic dose 100 mM is this the 
same solvent concentration used as for the tested low concentrations? 
ANSWER FROM AUTHORS: We thank you for the relevant comment. We have included 
the concentrations information in Protocol section 3.1.1 
Minor Concerns: 
The information in the figures could be cleared, e.g. the concentrations of APAP tested 
in Fig 2 and 3 should be written out in the Figure. 
ANSWER FROM AUTHORS: We thank you for the relevant comment. We have included 
the concentrations of APAP tested in Fig 2, 3 and 4. 
Reviewer #4: 
Marin et al. assembled Intestine only 2-OC, Liver only 2-OC, and Intestine/Liver 2-OC 
using Two-Organ-Chip from TissUse GmbH. The intestinal barrier was emulated by a co-
culture of Caco2 and HT-29 cells, and the liver was emulated by spheroids made of 
differentiated HepaRG cells co-cultivated with human hepatic stellate cells. These 2-OC 
assemblies were exposed to APAP to investigate its PK and toxicological properties. 
Authors describes the methods for organoids production and APAP pharmacokinetic 
and toxicological properties assessments in the MPS. 
The manuscript is written precisely the methods and indicates the application of 2-OC 
assembly to APAP PK and toxicological analysis properly, thus the reviewer thinks the 
manuscript has enough quality for the publication in JoVE with minor revision. 
l. 68 "Organoids made of human cells increase translational relevance." requires 
adequate references.  
ANSWER FROM AUTHORS: We performed the alteration required 
 
l. 76 "This technology can significantly improve the prediction of compound intestinal 
absorption and liver metabolism." Requires adequate references.  
ANSWER FROM AUTHORS: We performed the alteration required 
 
l. 96 Refs 16 and 17 should be replaced with more adequate references regarding the 
relationship of hepatocyte or enterocyte functionality and the mechanical stimuli. 
l.100 Is the 9:1 proportion really "the best" condition for the physiological parameters? 
ANSWER FROM AUTHORS:  We thank the reviewer for the pertinent comment. The ratio 
of 1: 9 was indicated by the literature as the ratio that provides results that are closer to 
the physiological ones.  The co-culture proportion of 9:1 between Caco-2 and HT-29 
showed to be the best to achieve physiological parameters after cell differentiation in 
culture [6], being the condition reported to enable reproducible results for drug 
permeability [7–9]. 
l.127 Is "DMEM" simple DMEM or DMEM supplemented with serum etc.? Definition is 
required. 
ANSWER FROM AUTHORS: we change the text and included the definition required ( 
Protocols section 1.1.1). 
l.143 TEER value, which indicates the good intestinal barrier formation, should be 
described. ANSWER FROM AUTHORS: Thank you for the pertinent comment. We have 
included TEER reference values (Protocol section 1.1.6, as well as experimental data ( 
Results section Figure 2 D and E). 



l.162 Is HHSTeC "primary" hepatic stellate cells, that means is HHSTeC not expanded 
after preparation of liver specimen? 
ANSWER FROM AUTHORS: HHSteC are guaranteed to further expand for 15 population 
doublings under the conditions provided by ScienCell Research Laboratories.  HHSteC 
from ScienCell Research Laboratories are isolated from human liver. HHSteC are  
cryopreserved at passage one and delivered frozen. 
https://www.sciencellonline.com/human-hepatic-stellate-cells.html). 
l.162 Is Stellate Cell Media equal to STeC CM? 
ANSWER FROM AUTHORS: yes, we reformulated the text to make this clear. 
l.174 Is Williams E medium simple Williams E medium or Williams E medium 
supplemented with serum etc.? The definition and notation of the medium name should 
be the same throughout the article. 
ANSWER FROM AUTHORS: we change the text and included the definition required ( 
Protocols section 1.2.1). 
l.186 Product information of 384 spheroid microplate is missing in the Table of 
Materials. 
ANSWER FROM AUTHORS: we included the information required 
l.215 Does the MPS just connect to the control unit, or does the circulation start at this 
point? If it starts, the condition of the circulation should be described. 
l.230 The manipulation is not clear. Moving the spheroids from 6 well plates to MPS 
accompanies the small volume of medium, so the volume of the medium in the smaller 
compartment increases after the manipulation. Should this increase be adjusted? 
l.233 Same as in l.215. 
l.238 Does this section describe the assembly of Intestine/Liver 2-OC MPS or the 
application of APAP to the Intestine/Liver 2-OC MPS? (i.e. l. 245: DMEM + test substance) 
ANSWER FROM AUTHORS: I.215; I230; I233; I238; I293; I298; I321 – question were 
addressed in the text. Clarifications were inserted in the respective Protocol text 
sections. 
l.264 What is the expiration date of APAP stock solution? Should it be freshly prepared? 
ANSWER FROM AUTHORS: In the present work the APAP solution was always freshly 
prepared. 
l.293 What is the flow condition? 
l.298 What is the volume of the sampling? Should the same volume of the media be 
added to each compartment of MPS after sampling? 
l.321 Same as in l.298. 
l.370 Should the stock solutions of APAP be prepared freshly? 
l.382 "The samples are prepared from a new stock solution, different from that used to 
generate a standard curve." Why the stock solution is different from that used for the 
standard curve? 
ANSWER FROM AUTHORS: Quality control standards are useful because they enable the 
user to verify the entire analytical system and eliminate bias from analytical results. 
During method validation, quality controls (QCs) evaluate the performance of a method 
and the stability of an analyte. Performance QCs are included in validation runs to 
determine the precision and accuracy of the method. Stability QCs evaluate the stability 
of an analyte under various stress conditions. 
l.467 The procedure of change the MTT solution to isopropanol should be described. 
ANSWER FROM AUTHORS: Modification performed 
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l.536 3,7%→3.7%?  
ANSWER FROM AUTHORS: Modification performed 
l.700 Cyp3A4: Human CYPs should be written in upper case.  
ANSWER FROM AUTHORS: Thank you for point it out. We performed the correction. 
 l.701 Fig. 3: The placement of characters in the figure is inappropriate. Consider the 
placement of E, F and G.  
ANSWER FROM AUTHORS: Thank you for point it out. We performed the correction. 
l.935 "There was a significant APAP decay under flow not seen without flow." The effect 
of flow for the liver organoid metabolic capability should be discussed more precisely.  
ANSWER FROM AUTHORS: We thank you for the relevant comment. We have included 
new experiments dataset obtained from albumin protein expression analyses and CYP 
activity characterization, as well as, new data discussion. 
 
Reviewer #5: 
Manuscript Summary: 
The method described in this manuscript is indeed of great importance for anyone 
working in pharmaceutical research, but also for toxicologists. APAP is a good model 
compound due to availability of human data. The APAP concentration used is reasonable 
and the authors are able to show intestinal drug absorption followed by downregulation 
of liver-specific genes in the liver spheroids. 
 
Major Concerns: 
The relative quantification method for RT-PCR experiments is not described.  
What was the basis for the selection of GAPDH as a reference gene? 
ANSWER FROM AUTHORS: We thank you for the relevant comment. Reference genes 
are expressed in several cell types showing slight variations in their expression levels 
and, therefore, being adequate to normalize the mRNA quantification data. Genes such 
as 18S rRNA, UBQ, RPL-19, GAPDH, β-actin, β-tubulin, PGK, and have been indicated as 
standards in RT-qPCR analysis. GAPDH is the most commonly used to normalize gene 
expression data, being used as an endogenous control in the quantitative analysis of RT-
qPCR, considering maintenance expression in many cell types. However, it is well known 
that these genes can vary in expression in different types of cells, reinforcing the 
hypothesis that there is no ideal reference gene. Regarding liver cells and enzymes 
involved in the metabolism function, the situation can be even more challenging and 
GAPDH may not be the most suitable gene. In this sense, a recently published study               
[10] ranks GAPDH in fifth place as a suitable reference gene for analysis of gene 
expression in HepaRG cells (cells used in the liver equivalent model of the present study). 
Despite the limitations described, we have confidence in the quality and reliability of the 
RT-qPCR data normalized by the GAPDH. New experiments of protein albumin 
expression analyzes, included in the present manuscript (Fig 4F), have correlated to the 
results of RT-qPCR. Just as there was a robust decline in the genetic expression of 
albumina 24 h after treatment with APAP under dynamic conditions, so did protein 
levels. This result gives us security and validates to some extent the normalization 
performed using GAPDH. 
Were additional reference genes tested?  



ANSWER: No additional reference genes were tested. Despite the recognized 
importance of using more than one reference gene (usually 3 genes) in the present 
study, only GAPDH was used 
 What about normalization? 
 ANSWER: All reactions were performed with reference dye normalization. The median 
cycle threshold value was used for analysis, and all cycle threshold values were 
normalized to the GAPDH mRNA expression level. 
 Software used? ANSWER: MxPro QPCR Software from MX3000P Stratagene system 
(Agilent Technologies (Santa Clara, CA, USA). 
NOTE: RNA was extracted from tissue equivalents using TRizol TM reagent (Thermo 
Fisher) according to the manufacturer's instructions. cDNA was synthesized by reverse 
transcription of 1–2 μg total RNA using SuperScriptIITM Reverse Transcriptase (Thermo 
Fisher). All targets were amplified using gene-specific primers and SYBR Green PCR 
Master Mix (Thermo Fisher) reagent. Each qRT-PCR contained 30 ng of reverse-
transcribed RNA and 100 nM of each primer. The reactions were performed using an 
MX3000P system (Agilent Technologies (Santa Clara, CA,USA)) and PCR conditions were: 
50 °C for 3 min (1 cycle); 95 °C for 5 min (1 cycle); 95 °C for 30 s, 59 °C for 45 s and 72 °C 
for 45 s (35–40 cycles).   
 
Minor Concerns: 
Line 669: What is meant by continuity? Barrier integrity? 
ANSWER FROM AUTHORS: Absence of any space or hole between neighboring cells. 
Means a completely intact barrier. 
Legend to figure 5: The term metabolism profile is misleading, as one would expect 
measurement of metabolites. Why not use "metabolic breakdown" or "APAP kinetics"? 
Modification performed 
General: The authors state that APAP was chosen because human PK data are readily 
available. A direct comparison would be helpful, e.g. in Figure 5 (show blood levels after 
oral administration). 
ANSWER FROM AUTHORS: we thank you for the timely suggestion. We inform you that 
we have included a comparative chart (Fig 5F) as well as the respective description and 
discussion. 
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  Dear Benjamin Werth, B.S. Science Editor of JoVE 

 

I am enclosing an invited manuscript for consideration for publication in Jove. The 

manuscript is entitled “Intestine/Liver Microphysiological System for Drugs 

Pharmacokinetic and Toxicological Assessment”. It has not been published elsewhere and 

that it has not been submitted simultaneously for publication elsewhere. 

Because the Microphysiolgical System (MPS) is a developing technology and there is a 

range of different types of it, we consider it very important to become known and established 

the pharmacokinetic parameters obtained specifically in the 2-OC MPS in a consistent way. 

This study shows the results obtained with paracetamol and highlights the crucial role of the 

presence of flow in the physiological response of MPS. The MPS emerging technology based 

on microfluidics device integrated with 3D human tissue culture models has great potential in 

providing data much more accurate and closer to human, capable of reducing the divergence, 

the time and the costs in scientific data, as well as encourage the availability and the diffusion 

of alternative methods to the animal use in research. The knowledge of the pharmacokinetic 

(PK) properties of a compound is crucial during the pre-clinical drug phase. The MPS that 

allocates the integrated intestine and liver organ models are the first bet in obtaining a 

high-quality pharmacokinetic dataset since those two organs are the critical ones in the 

process like biodistribution and bioavailability and other parameters like intestinal rates of 

permeability and absorption as well as hepatic metabolism. This article describes the detailed 

protocols to perform the emulation of the APAP intestinal absorption and hepatic metabolism 

and respective analyses in the 2-OC MPS composed by the human intestine and liver 

equivalents. The article also described the proper human tissue functionality and toxicological 

analyses necessary to validate the PK results. For those reasons, we considered this article 

of a very interesting for the scientific community. 

The manuscript has undergone some changes suggested by the reviewers. We strive to 

balance compliance with all reviewers' suggestions and requests and compliance with JoVE 

rules, guidelines, and space limits. I inform you that new results have been included in the 

manuscript, figures 2,3,4 and 5 have been reformulated, as well as several parts of the text. 

Text changes are highlighted in gray. The parts of the filming protocol highlighted in yellow.  

We are grateful for the careful review of the manuscript and the important considerations made 

by the reviewers, which have resulted in a significant improvement in the quality of the work 

presented and we are thankful for the opportunity to resubmit the revised work. 
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